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I recently installed PCLinuxOS on my best friend’s
computer. It’s an older Dell Vostro 1000, and it
originally came with Windows XP. He bought it
around the same time that Vista was being
announced. He had expressed some concern over
continuing to run WinXP, and has had a series of
problems with WinXP slowing down periodically …
as WinXP is/was prone to do. When it would, he’d
bring it over to me to clean it up. His computer was
the ONLY computer running Windows that I would
even attempt to clean and fix. For everyone else, I
recommend installing PCLinuxOS, or finding
someone else to fix
their computer. If they
choose the former, I
will continue to offer
assistance.

Now my best friend
isn’t exactly the most
tech savvy person.
But since WinXP is
no longer supported, I
suggested that he
install PCLinuxOS on
his computer. I’ve
been giving him the
“sales pitch” for most
of the last year, off and on. You know the pitch … no
viruses, no malware, no spyware, improved security,
runs faster on older equipment, yada, yada, yada.

He has also seen me run PCLinuxOS here at my
house over the past several years, and he knows
how few problems I’ve ever had with it running on
my several computers. The problems I’ve had are
miniscule compared with his every three to six
month “clean up” and “update” needs. So, the “sales
pitch” certainly fell on receptive ears.

So, we decided to wait until after the holidays were
over. He brought his laptop over to me on January
20, 2015, and as soon as he left, I got busy installing
PCLinuxOS on it. Now my wife also had the same
model laptop, purchased around the same time as
his. The screen went out of hers, so I took it over
and hooked it to an external monitor. To this day, it’s
still in use, dedicated for use as the computer that
runs my “scanning station.”

I’m glad I didn’t just hand him a Live CD/DVD and
ask him to “have a go” at running it from the live

disc. I had forgotten
since installing
PCLinuxOS on my
wife’s Vostro 1000
how Dell’s
configuration caused
certain problems
when installing
PCLinuxOS. I was
quickly reminded.

The first obstacle to
overcome was that
the installation would
“hang” at detection
of the video card. In

this case, it was an “older” ATI/AMD chipset. So,
after repeated failures, I decided to install
PCLinuxOS using the generic VESA driver. Success!
One hurdle overcome.

Having finally gotten PCLinuxOS installed, the next
hurdle was getting the wireless card recognized and
set up. This particular model used the infamous
Broadcom 4311 wireless networking card. After a
short trip to the PCLinuxOS forum to refresh my
memory on what to do, I took his computer to a
location near one of my routers and connected it to

the internet via an ethernet cable. Once connected, I
had to uninstall all the Broadcom “wl” drivers, and
install everything related to the b43 Broadcom
drivers. I also had to “blacklist” the Broadcom “wl”
drivers, and add the b43 drivers to
modprobe.preload.

Once I turned on the wireless (I had, in desperation,
toggled the keystroke combination that toggles the
wifi off and on with the “wl” drivers), I then had to
switch from the device labeled “Broadcom” to the
one labeled “wlan0.” Voila! The wifi lit up without
effort. All I needed to do was configure the WPA-
PSK password, and we were off to the races.

Of course, I did a lot more tailoring and
customization to his computer. I placed launchers on
the top Xfce panel for frequently accessed tools and
programs. I also made it possible for him to make
network connections without the need to do so as
the root user. I installed some “extra” programs that I
knew he would like, as well as downloading some
special hunting and fishing wallpapers that I set up
to randomly change under Xfce’s built in desktop
slideshow.

He came over on Sunday, January 25, so I could
show him the things he needed to do “differently”
under PCLinuxOS. I took about an hour to go over
everything with him, like how to regularly apply
updates, how to connect to wireless networks, and
the few differences of how you do things under
Linux, versus Windows.

So, how did it go? To use one of his phrases, he was
as “pleased as a pig in slop.” To paraphrase him, his
computer ran faster than it had ever run, and he was
once again enjoying the use of his computer. He had
previously abandoned using his computer under
WinXP, since it just kept running slower and slower,

Welcome From The Chief Editor
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and since he was concerned about the security
vulnerability hype after support for WinXP had
ended. Plus, just as before, he knows exactly where
to bring his computer when it needs attention – and
I’ll gladly supply all the support he needs. After all is
said and done, chalk up another Windows to Linux
convert!

Until next month, I bid you peace, happiness,
serenity and prosperity. Screenshot ShowcaseScreenshot Showcase

Donate To PCLinuxOS
Community Supported.

No Billionaires/Millionaires.
No Corporate Backing Or Funding.

Click here to make a one-time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

Posted by Aleph, January 5, 2015, running IceWM.

Welcome From The Chief Editor

http://www.pclosusers.com/services-signup.php
http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
http://www.commandlinefu.com
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by Paul Arnote (parnote)

One of the things “we” (my wife and I) wanted for
Christmas was the Google Chromecast. If you’re not
familiar with it, it’s a device that plugs into an HDMI
port on your TV. With it plugged into your TV, you
can “cast” any tab from the Google Chrome browser
to your TV, in high definition. Instead of getting it for
Christmas, we ordered it from Amazon after
Christmas, using an Amazon gift card a friend of
ours gave us for a Christmas present.

The Chromecast appliance (for sake of a better
word) costs $35 (U.S.). It comes with an HDMI
extension cord and an AC adapter. It connects to
your 802.11 b/g/n network. Currently, it “officially”
supports playback from YouTube, Netflix, HuluPlus,
Pandora, Google Play, Plex, VUDU and a whole
host of other content providers.

Once you have the Chromecast attached to your TV,
you are instructed to travel over to
http://chromecast/setup. When you get there, you
are going to see something that might discourage or
deter a less tech savvy user.

Chromecast-Setup-Page.png

Thankfully, you can set up Chromecast with your
smartphone or tablet. On your portable device,
install the Chromecast app. Don’t worry. The app will
be useful, allowing you to stream content from your
portable device to your TV, via the Chromecast. You
can also use the app on your tablet or smartphone
to personalize the background images that
Chromecast displays on your TV when it’s not
streaming content.

As a side note, I’d like to mention something, and it’s
directed squarely at Google. Thanks a million
Google, for leaving Linux users out in the cold. You
use Linux to run virtually your entire business, and
even base your Android OS on the Linux kernel. It
really wouldn’t hurt you to give a little bit back to the
Linux community by at least supporting the same
OS that you use to profit so much from. But that’s
OK. Us Linux users are used to adapting and
overcoming these kind of obstacles, even if it means
doing the initial setup from an alternate platform.

Next, you need to download the Google Cast plugin
for the Google Chrome browser, which does work
under PCLinuxOS. Firefox will not work with the
Chromecast device, and I could find no plugins
available to make it work. There are reports of
Chromecast working with the beta version of Opera,

via a special Opera plugin. Chromecast also works
well with the Chromium browser. Most other
browsers are “out in the cold” at this time, or so it
would appear.

The above screenshot shows the settings for the
Google Cast plugin. During the setup procedure, you
can give your Chromecast device a unique name.
Connect your Chromecast to your home wifi network
by selecting your network, then providing your wifi
password. The entire process takes less than five
minutes to complete. We named our Chromecast
“Paul & Laura & Ryan.”

There are two ways to broadcast from your
computer to your Chromecast, using the Google
Cast plugin. First, you can “cast” the contents of any

Chromecast On PCLinuxOS

http://chromecast/setup
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tab in Google Chrome to your Chromecast. Select
“Cast this tab” button from the window for Google
Cast. Playing the video “full screen” within the tab
will maximize the size of the video on your TV.

The other way is to click on the “Cast” button under
the video on content providers who support
Chromecast. In the image above, from YouTube, the
“Cast” button has been added to the far right side of
the playback controls.

If you find that Google Cast is hesitant to send a
video to your TV via Chromecast, there is the PlayTo
for Chromecast plugin. This Google Chrome browser
plugin will automatically detect videos on an open
tab in Google Chrome and offer to send the video to
your TV.

Increasingly, Chromecast is becoming the industry
standard. A lot of that is due to its very attractive
price. Although it is limited to streaming a 720p

picture, that level of resolution looks excellent on my
HDTV. VLC is working on adding Chromecast
support, although no timeframe has been offered for
when it might appear. All the developers say is that
they are working on it. Popcorn Time, the program
that streams torrents to your desktop, has added
Chromecast support to the latest releases of their
program.

Expect Chromecast to receive some significant
competition. There is a Kickstarter campaign to build
a new device called Matchstick. You can also learn
even more here. It will be powered by the Firefox
OS, and is expected to sell for $18 (U.S.).
Matchstick is an open source platform, and they
have opened up a full developer site for those
working on building apps for the new platform.
Amazon has already come to market with their $39

(U.S.) Fire TV Stick, which was advertised heavily
(in the U.S.) in the days leading up to the Christmas
holiday. There are also a whole host of cheap
Chinese import devices, from which you will receive
widely varying results, according to the reviews I’ve
read. The old adages “buyer beware” and “you get
what you pay for” should be heeded when buying
one of these latter devices.

Recently, there was a thread in the PCLinuxOS
forum about how to save money in the new year. It
centered around “cutting the cord” for cable TV, and
replacing cable TV with over the air HD broadcasts
and streaming media. With the increasing adoption
of high speed internet connections, more and more
people are doing exactly that. Chromecast definitely
makes “cutting the cord” much easier.

Screenshot ShowcaseScreenshot Showcase

Posted by nymira, January 25, 2015, running LXDE.

Chromecast On PCLinuxOS

http://www.matchstick.tv/
https://hacks.mozilla.org/2014/09/matchstick-brings-firefox-os-to-your-hdtv-be-the-first-to-get-a-developer-stick/
http://www.amazon.com/Amazon-W87CUN-Fire-TV-Stick/dp/B00GDQ0RMG/ref=sr_1_1?ie=UTF8&qid=1421213035&sr=8-1&keywords=fire+stick
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by Meemaw

Many of the wallpapers and Impress backgrounds I
have seen seem to have a kind of “whispy” or
feathered background. Solid colors are nice, and so
are gradients, but this tutorial I found gives us
another option. We will use Spiro and Clones in
Inkscape, along with a few other skills we have
learned along the way. In this one, I went into
Document Properties and unchecked the page
frame and shadow checkboxes at the bottom so I
have lots of room to work without seeing the page
outline in the background.

First, click on the pen tool. In the tool config at the
top of your window (shown below), click on the
Spiro tool, then draw a curved path with 5 points.

All segments should be curves. As soon as you
finish the curve, it will change to a spiro curve.

Click on Path > Path Effects to open that window.
You will see that the Spiro spline is already present
in that window as it is a default in Inkscape now.

Next, we will add a triangle “brush” to our spiro curve
using the Path Effect Pattern on Path. Using the
pen tool, draw a triangle. While it is selected, copy it

to the clipboard using Edit > Copy (or <CTRL> + C).
With the Path Effects dialog open, choose Pattern
on Path from the dropdown, then press the Add
button

In the Path Effects dialog, click the clipboard icon to
paste the triangle we copied there. The triangle is
the pattern (“brush”) we are putting on our path (the
spiro). Your spiro should now look something like
this.

Now, we will unset the fill and the stroke of the
tapered curve that we are going to use. Right click
on the “None” label next to fill in the bottom left
corner, and choose “Unset Fill” from the menu that
appears. Right click on the black box next to stroke
in the bottom right corner, and choose “Unset
Stroke” from the menu that appears (next page, top
left).

Next, we need to clone our path, move the clone
away from the original, change the color to
something other than black, and duplicate it several
times. Select the path with the select tool, then make

Inkscape Tutorial:
Creating A Feathered Background
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ONE clone of it, using Edit > Clone > Create Clone
or ALT + D. Separate your clone from the original
curve so you have room to work.

The curve selected is the clone, and I’m going to
separate them more. Change the color of the clone
either with the palette at the bottom or the Fill /
Stroke dialog. Only the clone should change color. If
both objects change, you are probably changing
the color of the original and you should grab the
other curve and work on it instead. Shown below,
the clone is the only one that changed color.

Duplicate the colored clone 30 or so times using
Edit > Duplicate or CTRL + D. Now, we are going to
use the tweak tool to jitter the position of our 30
clones, as well as jitter some the saturation and
lightness values of the clones.

Using the select tool, click and drag around the
clones to select all 30. If you aren’t sure, look in the
status bar at the bottom of your window, which
should say something like “30 Objects selected….”
Click on the tweak tool in the toolbox, then look at
the configurations across the top of your page. The
Tweak tool has three modes for moving objects but
you want Move Objects in Random Directions.

Now click and drag the tweak tool over the clones
and watch them move. If they don’t look like they are
moving much, you may need to play with the Width
and Force values of the tweak tool. I used 25 for
Width and 20 for Force. The selection outline of the
objects will disappear when using the tweak tool, so
you won’t see all the dotted lines around everything.
Your end result should look something like this (top,
right):

With the 30 clones still selected, open the Fill /
Stroke Dialog, and lower the opacity of the clones.
The tutorial used 30%, so I did too.

With all clones still selected, go back to the Tweak
tool, and this time set the mode to Jitter Colors.
Make sure the only 2 values checked/toggled are
Saturation and Lightness. On my desktop the
channels show as toggle buttons in the toolbar,
since my screen is wider. In a smaller window they
will be hidden in a dropdown. Click and drag over
the clones and watch their colors change slightly. If
they change too much, consider tweaking the Force
value.

Inkscape Tutorial: Creating A Feathered Background
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If we want to, we can play with the original that all
our clones are based on, as well as our triangle
“Brush”.

Select the black original, and change to the node
tool. The familiar node editing handles should
appear. Move the nodes of your spiro to make a
better curve. Notice that your creation will update
with the changes to the black original path. Play
around with it until you get something that you want.

You can also change the “Brush” we used to create
the curve design. Click on the Show Pattern
Source button in the Path Effects dialog, and
somewhere on the Inkscape canvas, your triangle
should appear (you may need to zoom out to see
where it appears. if it is far from your drawing, select
all 3 nodes and move it closer.)

Can you see my triangle? Now, using the node tool,
edit the triangle shape, adding and moving nodes.
Your changes should update as you go on the black
original path, and also the blue clones. Cool, huh?

Let’s do a bit more. Group your clones together, then
duplicate the group 2 or 3 times, rotate each one a
bit, and change the opacity of each group. When I
got close to what I wanted, I found that I wanted it a
bit more blue with less white, so I duplicated the
whole grouping once more.

Now, you can finish this one of two ways. You can
draw a rectangle over the area, and use a clipping
path to create a rectangular background, or you can
go back to Document Properties, make your page
visible by checking the page border checkbox, place
your finished texture over it and export the PAGE as
a bitmap.

After I finished the background, I then used it to
create a background for a LibreOffice Impress
presentation.

The great thing about this project is that you can
always go back and change the curve, or the brush
(or both) and the color and have another feathered
background to use for whatever you want.

Inkscape Tutorial: Creating A Feathered Background
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Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Posted by Yankee, January 5, 2015, running LXDE.

http://pclostalk.pclosusers.com
http://www.cafepress.com/pclinuxos
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I never have distress 'cause I use PCLOS

In the morning

When I turn on Tex's system I just can't resist him

In the morning

Where the mouse pad lingers

Cords twining on the floor

Screen starts a glowing

As I press start once more

I am so very pleased as I wander among the keys

In the morning

Viruses don't flutter up trojans never clutter up

Nothing alarming

If I had a dev's touch for only a day

I'd make a popup and here's what I'd say

You'll never have distress if you use PCLOS

In the morning

I'm never a loser 'cause I'm a Linux user

In the morning

It is open source so easy to use of course

In the morning

Try the console mode

So fun to learn the code

Choose your favorite distro

It'll cost you no dough

Listen to my voice Linux is about choice

In the morning

There is nothing to it just get up and do it

You'll find it charming

If I had a dev's touch for only a day

I'd make a popup and here's what I'd say

You'll never be a loser if you're a Linux user

In the morning

MP3 OGG

ms_meme's Nook: PCLOS In The Morning

http://pclosmag.com/html/Issues/201502/files/pclosinthemorning.mp3
http://pclosmag.com/html/Issues/201502/files/pclosinthemorning.ogg
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Ingredients

Enchiladas
4 - cups shredded chicken
9 - slices bacon, crisply cooked and crumbled
1 - packet (1 oz) ranch dressing & seasoning mix
1 - pouch (8 oz) roasted tomato Mexican cooking

sauce
2 - cups shredded Mexican blend cheese (8 oz)
20 - flour tortillas for soft tacos & fajitas (6 inch)

Garnishes, as desired

Chopped fresh cilantro
Chopped fresh tomatoes
Chopped red onion

Directions
Heat oven to 375° Lightly grease 13x9-inch (3-
quart) baking dish and 8-inch square (2-quart)
baking dish.

In large bowl, mix chicken, half of the crumbled
bacon, 1 tablespoon of the ranch dressing &
seasoning mix, the cooking sauce, and 1 cup of the
cheese; mix well. Divide mixture among tortillas, and
roll up, placing seam side down in baking dishes.

Set aside. If you want to freeze the smaller baking
dish of enchiladas at this point, cover the baking
dish with foil, and label before placing in the freezer.
Use within 1 month.

In 10-inch skillet, heat oil over medium-high heat.
Cook onion in oil until softened. Add chilies, and
cook until most of the liquid from chilies evaporates.
Stir in flour. Slowly add chicken broth, stirring
constantly to prevent lumps.

Once broth is incorporated, cook another minute or
until slightly thickened. Stir in sour cream and
remaining ranch dressing & seasoning mix, and
simmer 1 minute.

Remove from heat, and pour over enchiladas. If
baking both baking dishes, pour the sauce over
both; otherwise, pour all of it into the 13x9-inch dish.
(To make just enough for the smaller pan of
enchiladas later, divide the recipe for the sauce in
half. Top with remaining cheese and bacon.

Bake about 20 minutes until cheese is melted and
sauce is bubbling. Cool 5 minutes before serving
with garnishes.

The PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner

Chicken Bacon Ranch Enchiladas

http://www.scribus.net
http://www.pclinuxos.com
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SplashData News Release

"123456" Maintains the Top Spot
on SplashData's Annual "Worst
Passwords" List

The 2014 list of worst passwords demonstrates the
importance of keeping names, simple numeric patterns,
sports and swear words out of your passwords.

Los Gatos, CA - January 20, 2015 - SplashData has
announced its annual list of the 25 most common
passwords found on the Internet – thus making them
the "Worst Passwords" that will expose anybody to
being hacked or having their identities stolen. In its
fourth annual report, compiled from more than 3.3
million leaked passwords during the year, "123456"
and "password" continue to hold the top two spots
that they have held each year since the first list in
2011. Other passwords in the top 10 include
"qwerty", "dragon", and "football".

As in past years' lists, simple numerical passwords
remain common, with nine of the top 25 passwords
on the 2014 list comprised of numbers only.

Passwords appearing for the first time on
SplashData's list include "696969" and "batman".
While Valentine's Day is less than a month away,
"iloveyou" is one of the nine passwords from 2013 to
fall off the 2014 list.

According to SplashData, the passwords evaluated
for the 2014 list were mostly held by users in North
America and Western Europe. In 2014, millions of
passwords from Russian accounts were also leaked,
but these passwords were not included in the
analysis.

SplashData's list of frequently used passwords
shows that many people continue to put themselves
at risk by using weak, easily guessable passwords.

"Passwords based on simple patterns on your
keyboard remain popular despite how weak they
are," said Morgan Slain, CEO of SplashData. "Any
password using numbers alone should be avoided,
especially sequences. As more websites require
stronger passwords or combinations of letters and
numbers, longer keyboard patterns are becoming
common passwords, and they are still not secure."

For example, users should avoid a sequence such
as "qwertyuiop," which is the top row of letters on a
standard keyboard, or "1qaz2wsx" which comprises
the first two 'columns' of numbers and letters on a
keyboard.

Other tips from a review of this year's Worst
Passwords List include:

• Don't use a favorite sport as your password –
"baseball" and "football" are in top 10, and "hockey,"
"soccer" and "golfer" are in the top 100. Don't use a
favorite team either, as "yankees," "eagles,"
"steelers," "rangers," and "lakers" are all in the top
100.

• Don't use your birthday or especially just your birth
year -- 1989, 1990, 1991, and 1992 are all in the top
100.

• While baby name books are popular for naming
children, don't use them as sources for picking
passwords. Common names such as "michael,"
"jennifer," "thomas," "jordan," "hunter," "michelle,"
"charlie," "andrew," and "daniel" are all in the top 50.

• Also in the top 100 are swear words and phrases,
hobbies, famous athletes, car brands, and film
names.

This is the first year that SplashData has
collaborated on the list with Mark Burnett, online
security expert and author of "Perfect Passwords"
(http://www.xato.net).

"The bad news from my research is that this year's
most commonly used passwords are pretty
consistent with prior years," Burnett said. "The good
news is that it appears that more people are moving
away from using these passwords. In 2014, the top
25 passwords represented about 2.2% of passwords
exposed. While still frightening, that's the lowest
percentage of people using the most common
passwords I have seen in recent studies."

SplashData, provider of the SplashID line of
password management applications, releases its
annual list in an effort to encourage the adoption of
stronger passwords. Slain says, "As always, we

The "Worst Passwords" Of 2014

http://www.xato.net
https://splashid.com


PCLinuxOS Magazine Page 14

hope that with more publicity about how risky it is to
use weak passwords, more people will start taking
simple steps to protect themselves by using stronger
passwords and using different passwords for
different websites."

Presenting SplashData's "Worst Passwords of
2014":

Rank Password Change from 2013
1 123456 No Change
2 password No Change
3 12345 Up 17
4 12345678 Down 1
5 qwerty Down 1
6 123456789 No Change
7 1234 Up 9
8 baseball New
9 dragon New

10 football New
11 1234567 Down 4
12 monkey Up 5
13 letmein Up 1
14 abc123 Down 9
15 111111 Down 8
16 mustang New
17 access New
18 shadow Unchanged
19 master New
20 michael New
21 superman New
22 696969 New
23 123123 Down 12
24 batman New
25 trustno1 Down 1

SplashData offers three simple tips to be safer from
hackers online:

1. Use passwords of eight characters or more with
mixed types of characters.

2. Avoid using the same username/password
combination for multiple websites.

3. Use a password manager such as SplashID to
organize and protect passwords, generate random
passwords, and automatically log into websites.

About SplashData, Inc.

SplashData has been a leading provider of
password management applications for over 10
years. SplashID Safe (www.splashid.com) has
grown to be most trusted multi-platform password
solution for both the consumer and enterprise
markets with over 1 million users worldwide.
SplashID Safe's popularity continues to rise as the
number of user names, passwords, and account
numbers most people have to remember is rapidly
multiplying. At the same time, the risk of this kind of
sensitive information falling into the wrong hands
has never been greater. SplashID Safe helps solve
this dilemma by creating an encrypted digital safe
available on smartphones, computers, USB keys, or
online, offering the peace of mind of being able to
access critical information whenever needed while
maintaining the security of 256-bit encryption.
SplashData was founded in 2000 and is based in
Los Gatos, CA.

Editor’s Note:

While SplashID Safe and SplashID Safe Pro don’t appear
to be available for Linux users, they are available for the
major portable device platforms. With that in mind, we
also realize that a lot of PCLinuxOS users have portable
devices – either iOS or Android powered devices – and
this information about the service holds some interest for
those users. Furthermore, the information provided in this
press release mirrors perfectly the information we have
previously run in The PCLinuxOS Magazine regarding
password security. As such, it bears repeating, and this
news release accomplishes that goal.

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark

Czechoslovakia

Italy

Poland

Brazil

The "Worst Passwords" Of 2014

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
http://www.fsf.org
https://splashid.com
http://www.splashid.com
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by daiashi

About The Game

Ever wanted to play Unreal tournament or Quake 3
Arena from a top down 2D perspective? Daedalus -
No Escape brings you exactly that, the same feel
and control as in an arena FPS but from top down,
in a dark sci-fi mood inspired by Alien Breed.

In control of a space marine, walk the arena and
defeat your opponents using powerful weapons. No
feelings, no mercy, only your gun does the talking.

Features

• single player, multi-player

• game modes: highscore, deathmatch, last man
standing, team deathmatch, capture the flag

• different control schemes: FPS-like, fixed camera

• 9 cool weapons

• lots of maps

• map editor

• original soundtrack

•Windows, Linux and Mac support

The game reminds me of a cross between Alien
Breed and Alien Swarm. It is a little fast paced,
similar to what a top view of Unreal Tournament
would be like.

System requirements:
Fully updated PCLinuxOS and Steam

Hardware:
Minimum:

OS: Linux (32 or 64bits)

Processor: dual core

Memory: 2 GB RAM

Graphics: OpenGL 3.0 compatible
graphics card

Hard Drive: 300 MB available space

About The Company

The game itself was created by Patrice Meneguzzi,
a 33 year old software engineer in France. He has
11 years under his belt working on web-based
applications using HTML, CSS, Java and Javascript.
He is a avid gamer and artist. Patrice’s ambition for
the game started back with Alien Breed and Quake 3
Arena.

Some Gameplay Screenshots

Game Zone: Daedalus - No Escape
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Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account,

if you do not already have one. Once you have
Steam up and running, go to the store tab. Click on
the Linux tab if you wish and search for Daedalus -
No Escape. Click on and download the demo. If you
have updated your system, including graphics
drivers, you should be good to go.

http://store.steampowered.com/app/315830/?snr=1_
7_tabpaginated__222_1

Full Monty ... Everything you might want or need –
plus the kitchen sink!

Game Zone: Daedalus - No Escape

http://www.pclinuxos.com/?page_id=1413
http://www.jupiterbroadcasting.com/tag/linux-action-show/
http://www.linuxquestions.org
http://www.linuxfoundation.org/
http://store.steampowered.com/app/315830/?snr=1_7_tabpaginated__222_1
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by edu.ro, January 3, 2015, running Openbox.

http://pclostalk.pclosusers.com
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by Paul Arnote (parnote)

Fonts, fonts, fonts. Everywhere you look there are fonts. Some fonts are simple
and easy to read. Some fonts are elegant and fanciful. Some fonts are whimsical.
Some fonts are casual. Some fonts scream formal. Some fonts are artful.
Whatever the case, you use fonts every day, yet I bet you don’t really give them a
whole lot of thought.

The pages of this magazine’s PDF utilizes a strict set of fonts to display the text
on your screen. Restricting the use of fonts this way helps insure that the
magazine has a unified and coordinated appearance. Typically, the fonts used in
the magazine are Liberation Sans (body text in the articles), Liberation Serif
(highlighted text in the articles), Liberation Mono (code examples), and Bitstream
Vera Sans (headlines). Typically, you’ll see these four fonts used in either regular,
italic, bold italic or bold typefaces. Usually, 10 point type (font size) is used for the
article body text (except for Liberation Mono, which is downsized to 9 points so it
doesn’t look so huge next to the better spaced proportional fonts), 30 point type
for headlines, 14 point type for the table of contents, and 18 point type for the
page numbers. Additionally, you may also notice the Walkway Expand Black font
used at the bottom of each page, as well as in the magazine’s masthead.

Like all other computer operating systems, Linux makes use of fonts to draw
information on your screen. Linux can use Postscript Type 1 fonts (encompassing
genuine postscript fonts from Adobe, which can take on file extensions such as
PFA and AFM under Linux, and PFM and PFB under Windows), TrueType fonts
(TTF files), and OpenType fonts (OTF files).

What are the differences?

To gain a better understanding of fonts, we first must understand the differences
between the different types of fonts that are available. Postscript files have been
around the longest, and are the font format preferred by commercial printers.
Before postscript files came along, most fonts were nothing more than bitmap
renderings of letters. Thus, bitmapped fonts didn’t render well, and certainly
experienced severe limitations when it came to scaling to other sizes.

TrueType fonts were “invented” by Apple (and subsequently licensed by
Microsoft, in exchange for Apple licensing Microsoft’s TrueImage postscript

compatible page description language) to allow font designers to determine
proper, scalable appearance of their fonts. TrueType fonts were designed jointly
by Apple and Microsoft in the late 1980s as an open format to compete with
Adobe’s closed format (and expensive to license) Postscript files. TrueType fonts
gave users the same appearance on their computer screens as the finished
document would look like from their printer. TrueType fonts can be scaled to
virtually any size. They made their first appearance with the release of Mac OS
System 7, and was followed up by their inclusion in Windows 3.1 later that year
by Microsoft. The original three TrueType fonts included with Windows 3.1 are
still an integral part of Windows to this day: Arial, Times New Roman and Courier
New.

OpenType fonts are an extension of TrueType fonts, collaboratively released by
Microsoft and Adobe (who joined in on the collaboration by the time OpenType
was publicly announced in 1996). OpenType, which is a registered trademark of
Microsoft, allows for greatly expanded character sets, as well as including data
structures that dictate typographical behavior.

ClearType, a Microsoft-only feature, refers only to a method of subpixel rendering
on the user’s screen to try to improve the screen appearance of displayed fonts.
It is not related to different types of fonts, and is applied to both TrueType and
OpenType fonts. There is disagreement among type aficionados whether or not
ClearType achieves its goals. ClearType is not used for printed documents.

Getting new fonts

PCLinuxOS comes with quite a few fonts already installed. But, since everyone’s
taste is different, you will most likely want to install some extra fonts on your
system. Different fonts will allow you to personalize your own PCLinuxOS
installation, just as you do with wallpaper.

Probably the easiest way to get new fonts is to install them from Synaptic. This is,
by far, the easiest way to install fonts. Just search with the term “font” and you will
find all sorts of extra fonts you can install. While in Synaptic, do a quick look to
see if the “webcore-fonts” package is installed. If it isn’t, go ahead and install it.
This package contains all of the fonts that are typically found on a Windows
installation. Here are the fonts that package contains:

Fonts Everywhere, Fonts For Everyone



PCLinuxOS Magazine Page 19

Andale Mono, Arial, Arial Black, Comic, Courier New, Georgia, Impact, Lucida
Sans, Lucida Console, Microsoft Sans Serif, Symbol, Tahoma, Times New
Roman, Trebuchet, Verdana, Webdings, Wingdings

The benefit of having these fonts installed is so that if a web designer has
specified one of these fonts as the default font for a web page, you will be able to
view the web page the way it was intended to be viewed. Also, if you receive or
send document files to Windows users, you can insure that any document are
viewable as intended by having the proper fonts installed on your computer.

If you dual boot your computer with a copy of Windows, there is another very
easy way to get all of your fonts transferred to your PCLinuxOS installation. Start
PCLinuxOS Control Center (PCC, a.k.a. Configure Your Computer). Click on the
“System” category, then select “Manage, add and remove fonts. Import
Windows(™) fonts” near the top of the window. You should now see a window
similar to the one above. At the bottom of the window, in the center, is a button
labeled “Get Windows Fonts.” Click it, and PCLinuxOS will search your mounted
drives (your Windows partition is mounted, right?) for the C:\Windows\Fonts
folder. When it is found, all of your Windows fonts will be imported into your
PCLinuxOS installation.

Of course, if you’re like a lot of us, you’ve abandoned Windows completely – and
long ago. So the above method won’t do anything for us, except pop up an error
message box that it can’t find any Windows fonts. By the way, you’ll also get the
same error message if your Windows partition isn’t mounted. If PCLinuxOS can’t
see it, then it also can’t find any fonts to import.

There are over 100,000 different fonts available. A good portion of those are
freely available. The rest are ones you have to pay for. We won’t even talk about
the latter ones. Many of them are quite expensive. There are more than enough
free fonts available to keep your mouth watering for years – and to meet virtually
any layout designs you could ever come up with.

Thanks to the internet, most of those free fonts can be found online. Above is a
graphic with the logos from 20 different sites that offer free fonts. Yes, they are
yours for the taking. All you have to do is download them. Well, that’s not ALL you

Fonts Everywhere, Fonts For Everyone
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have to do – you do have to install them on your PCLinuxOS installation – but
we’ll talk more about that in a minute. But you will have to download them, still.

Below are the links to the 20 sites in the image above. Those sites with an
asterisk next to them are actually font foundries (they make and sell fonts), but
they also offer up some high quality free fonts.

Open Font Library
Fonts2U
Free Fonts Download
Font Garden
HypeForType*
betterfonts
FontZone
Google Fonts
Abduzeedo Design Inspirations Friday Fresh Free Fonts*
ActionFonts
FreeFonts
Chank Fonts!
FontSpace
Creative Bloq
Font Squirrel
Simply The Best Fonts
Urbanfonts
1001 Free Fonts
FontPalace
dafont.com

This list is far from complete. There are literally thousands of sites out there
offering up free fonts for your use. These 20 sites should give you plenty of
places to start looking to fulfill your font needs. Some fonts have restrictions on
them, offering them up only for your own personal, non-commercial use. Use of
these fonts commercially requires them to be purchased. Other fonts are
completely free for your use, however you choose to use them.

While the chances of you being hunted down for use of the fonts for other than
the use they are “licensed” range from slim to remote to none (after all, no one
can possibly review or scrutinize every item that is published), it might be best to
play it safe and find an alternative font that can be used in the manner in which
you want. Otherwise, you may find yourself in some legal entanglements that you
might wish to avoid, as well as some expenses you didn’t anticipate.

Also, the Google Fonts site operates in a rather unique way. You add whatever
fonts you like to your “collection,” and then you download your entire collection as

a compressed ZIP file. Uncompress the file to a folder in your /home directory,
and then you can go about installing them to your PCLinuxOS installation.

Installing your fonts

PCLinuxOS users have it pretty easy when it comes to installing and managing
the fonts on their system. PCC has a feature built into it that makes the
installation of fonts painless and easy.

First of all, you can view all of the fonts installed on your computer. Select an
installed font from the list and you can view a sample or preview of that font in the
“Preview” window. You can also change the size of the text displayed in the
preview window, simply by selecting the size you want your preview text to be
along the right side of the window.

Fonts Everywhere, Fonts For Everyone

http://openfontlibrary.org/
http://www.fonts2u.com/
http://www.ffonts.net/
http://www.fontgarden.com/
http://www.hypefortype.com/browse-fonts/free.html
http://betterfonts.com/
http://fontzone.net/
https://www.google.com/fonts/
http://abduzeedo.com/tags/ffff/
http://www.actionfonts.com/
http://www.free-fonts.com/
http://chank.com/freefonts.php
http://www.fontspace.com/
http://www.creativebloq.com/graphic-design-tips/best-free-fonts-for-designers-1233380
http://www.fontsquirrel.com
http://simplythebest.net/fonts/
http://www.urbanfonts.com/free-fonts.htm
http://www.1001freefonts.com
http://www.fontpalace.com
http://www.dafont.com
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To install your downloaded fonts, select “Import” button. You will see a dialog box
similar to the one above, but empty. Click on the “Add” button, travel to the folder
where you extracted or stored your downloaded fonts. Select the fonts you want
to install, then click on OK. Once you have all the fonts added that you want to
install, select the “Install” button. PCC will install the selected fonts into the
usr/share/fonts folder, where they will be available to every user on that
computer.

If you want the selected fonts to only be available to the current user, you will
have to first create a .fonts directory in your /home directory (if one doesn’t
already exist). Then, you will have to manually copy fonts into that folder.

While you’re installing your new fonts, it might be a good idea to check the
options you want to use with your new fonts. By default, all of the choices are
selected. If you find some reason to not want your new fonts to be available to
any of the choices listed, you can clear the checkmark and select the “OK”
button.

Similarly, if there are any fonts installed on your system that you want to uninstall,
select the font from the list. Then, select the “Uninstall” button. That selected font
will be removed from your system.

Although font tools are few and far between under Linux, you do have a couple of
other options in PCLinuxOS. First, there is GNOME Font Manager (pictured
below, top of next column). It has the same functions as the PCC utility, allowing
you to install and remove fonts from your system, and to view the fonts installed
on your system. Font Manager will list all the fonts it finds, including system fonts
(installed in /usr/share/fonts) and any user fonts (installed in the .fonts folder in
that particular user’s /home directory).

Fontmatrix

Gnome Font Manager

Fonts Everywhere, Fonts For Everyone



PCLinuxOS Magazine Page 22

Fontmatrix is another option for managing the fonts on your computer. The
“About” dialog box pretty well sums up the function of Fontmatrix. Just in case
you can’t read it clearly, here is what it says:

Fontmatrix

A font manager for Linux.

Fontmatrix is aimed at adventurous graphic designers and typesetters who need
to manage hundreds and even thousands of fonts for their work - avoiding the
need to browse overly long lists in dialogs.

Basically, Fontmatrix helps you do three things:

* Activating and deactivating your fonts
* Tagging fonts with sets
* Finding suitable fonts by constructing simple or complex queries
* Refining the fonts selection by comparing glyphs in detail
* Generating font “books” as PDF

Find more at fontmatrix.net or from built-in help system.

OK. So Fontmatrix may be overkill for the average user. But Fontmatrix is also
the ONLY program that allows the user to view fonts that aren’t installed on their
computer, short of opening them into a full blown font editor, such as Fontforge.
You can set custom text to be used for displaying the selected font (as I’ve done
in the screen image above). Fontmatrix is a program built on the Qt libraries.

There are some users who have large collections of fonts. I’m not talking about a
couple or few hundred. I’m talking about thousands (one PCLinuxOS user I know
has over 2,700 font files in his collection). Obviously, they won’t want to have all
of those fonts installed all of the time. Fontmatrix is perfectly suited for these
users, since they can activate and deactivate entire groups of their font collection
as needed.

Summary

I am utterly amazed at the lack of something so seemingly simple as a font
viewer under Linux. As much as I hate to admit it, Windows users have many,
many choices when it comes to font viewers. Even just double clicking on a font
file in Windows brought up a rudimentary built-in font viewer that allowed you to
see what any font file would look like on your system, even without it being
installed on your system.

Dolphin, the default file manager on KDE has the ability to view font files in a
similar rudimentary font viewer, simply by clicking on it. Plus, the font doesn’t
even have to be installed, which is a true plus. But not everyone runs KDE, so
they don’t have the “luxury” of Dolphin’s special built-in capability. Some users
simply don’t care for KDE’s bloat and eye candy. Others may not have computers
capable of running KDE well, so they opt for using one of the lighter desktop
environments. I’m an Xfce user, and I don’t have the ability to easily view font
files. MATE and LXDE users are in a similar boat, as are users of the GNOME
and Unity desktops (from what I’ve read). As far as I know, KDE is the only
desktop environment where users can view fonts easily.

So, obviously it’s possible to create such a program. All of the programs we
talked about in this article have the ability to display a sample of text using the
selected font, albeit most of them being restricted to only viewing installed fonts.
What’s unclear is why someone hasn’t made a font viewer that can view any font
file, without it being installed on the user’s computer. It sure would be nice to be
able to double click on a font file and have a sample of that font displayed. We
can only hope for such a program, at this point.

Fonts Everywhere, Fonts For Everyone

http://www.linuxfoundation.org/
http://www.fontmatrix.net
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Linux Training
Courses & Classes

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Posted by Crow, January 18, 2015, running KDE.

http://www.linuxfoundation.org/
http://www.beginlinux.com/
http://www.fsf.org
http://www.pclinuxos.com
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By: Khadis

Creating a water (or blood) drop or splash in
Inkscape is radically easy and simple. If you are
going to create it, you just need one tool to do it.
Let’s go!

• Open up your Inkscape and create an oval of any
size and any color using Circle tool (F5).

• Grab your Tweak tool (Shift + F2) and activate
Push parts of paths in any direction option. Here
are some of other parameters that you can set:

• Click and hold any side/part of your oval, then
drag it out. On my example, I dragged out the upper
part. Your first result on the edge might be like this:

• Still using Tweak tool, click and drag several times
on the edge (including “undoing” if you get bad
result) so the result will be like this (yours may be
better):

• Do tweaking again for other parts. You might need
to do a circular movement or drag calmly and gently.

• Here are some of my creations. Not so good, but I
am sure that you’ll be inspired to create the better
and realistic one:

Inkscape Tutorial:
Creating A Water Drop Illustration
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• To get different effect, you can always change the
width of tweak area and the force value. You can
also switch from Push parts of paths in any
direction to Shrink (inset) parts of paths option.

• For the next touch, you can duplicate (Ctrl + D)
the object, give it a different color (I chose the darker
color), add a stroke, send it to back, and move it
some millimeters to create a shadow effect.

• You can also put text above the objects like this:

• I used the Impact font, while you can choose your
favorite font. Resize it to fit your main object.

• Then, I rotated the text, duplicated it and picked a
darker color for the duplicated one, and also moved
the duplicate to higher position. It will give a shadow
effect too.

• If you think that the text isn’t good yet, you can
modify it by giving it a “shattered” effect. Here is
how:

• Type your text. Then, by using the Bezier tool
(Shift + F6) create some objects (example: triangle
or any random shape), and put them above the text,
similar to the picture below:

• Then, do Difference (Ctrl + -) operation by
clicking on the Bezier object, then hold your Shift
button, click on your text, and press Ctrl + -.

• Apply the text to your water drop object.

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Inkscape Tutorial: Creating A Water Drop Illustration

http://www.cafepress.com/pclinuxos
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as told to Smileeb

How old are you?
I'm 59.

Married, single or
what?
Married to my wonderful wife Elke for 37 years.

Children, grandchildren?
No.

Retired or working and for how long and at
what?
Semi-retirement since May 2014. I've been working
in IT since 1976, first as a developer at a
government agency for statistics, then as a systems
analyst at Prime Computer (my best job ever). After
two stints at software companies I landed at a
wholesale company as a database developer, where
I've been for close to 20 years now.

What is the area you live in like. Weather,
Quietness, Scenery?
We used to live in Dusseldorf, which is beautiful. It's
where I met my wife in school. It's just north of
Cologne, and south to the so-called “Ruhrgebiet”,
the former coal and steel-producing region.

The weather is usually moderate, but very
unpredictable. Any forecast above 2 days in
advance is more or less a guess, even for the
meteorologists.

Now we live just outside of Dusseldorf, where the
hilly region begins (expanding to the East), so we're
able to get into the more rural areas quickly, which is
really nice.

Are you handy with your hands and have any
hobbies?
Sadly, besides handling computer keyboards, not so
much, although I managed to build my own PC in
the summer (and I'm darn proud of the result too :-)).
My wife and I used to play Bowling, teach Bowling to
youngsters – we were really into it from 1979 until
around 2000.

The last piece of wood I handled myself was making
a bookshelf during my last year in school in East
Orange, N.J., where I was born and grew up (yes,
I'm a U.S. citizen). Nowadays, I'm sorry I didn't have
the opportunity to become more of a craftsman.

What is your education level?
The German “Abitur” is comparable to completing
Junior college. After that I took a 4 month long
seminar in computer techniques (remember, it was
1975!). Punchcards, etc.

Do you like to travel, go camping?
We haven't gone camping for the last 40 years, but
we love to travel, near and far. Vacations at the
Mediterranean in Italy and Spain, the North Sea in
Germany, Belgium Holland. And whenever we get
the chance, we visit my Dad in Rhode Island and
spend a little time in Cape Cod.

What caused you to try Linux and join this
forum?
First, my employer started using Unix servers for the
Oracle databases, so I decided I'd find a niche and
put Linux on my personal box (clients were all M$).
That was in 1998. After several years I was one of
the “experts” whenever Unix came up (yeah, right). I
used Suse for years, then a few other distros, but
then (around 2008) I found my home – PCLinuxOS!

After about a year, reading along, I decided to be
brave and join the forum. This was my first
experience communicating on a computer using
anything other than personal emails.

Let me finish by saying that I absolutely love PCLOS
and its community. Nothing compares to this OS or
the people associated with it!

Dusseldorf (with the river Rhine)

PCLinuxOS Family Member Spotlight: tbschommer
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PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb in the PCLinuxOS forum expressing your interest.

Screenshot ShowcaseScreenshot Showcase

Linux Docs
Linux Man Pages

A few impressions of Haan (where we currently live)

Posted by Meemaw, January 7, 2015, running Xfce.

PCLinuxOS Family Member Spotlight: tbschommer

http://www.opensource.org/
http://www.die.net/
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 215, average score 151.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201502/files/2015-02-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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1. Modeling environment for simulating
phenomena

2. First high level language and written only
in caps.

3. Designed to make development of
programs easier

4. Used for creating GUIs for Windows
systems

5. Emacs Lisp
6. Written by David Korn
7. GNUs Ubiquitous Intelligent Language

for Extensions
8. Notation system which uses symbols to

shorten the code
9. An array processing language
10. Descended from WATFOR
11. List Processing
12. Brings modern language features to C
13. Language where programs can be

developed in separate modules
14. Language to formally state the

algorithms for solving complex problems
15. Programmed the Apple Newton PDA
16. High level language primarily intended

for numerical computation
17. Unified Extended Dialect of ICON
18. Mainly used in programming of large

data sets
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APL

DYLAN

ELISP

FORTRAN

GUILE

HASKELL

ICON

KORN SHELL

LISP

MODULA

NETLOGO

OCTAVE

PASCAL

UNICON

VALA

VISUAL BASIC

WATFIV

YORICK

ZPL
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